
Print-Tool - Version 2.0 - User Guide 

Print-Tool has been developed by Roy Harrington for those of us wanting to gain control over the 
printing process and overcome or master the differing and, at times, conflicting approaches to 
printing images that have been introduced during the last few years by the computer, software and 
printer suppliers such as Apple, Adobe and Epson. 

PRINT-TOOL 2 - FEATURES 

• Position and resize multiple images on a page 
o simple drag and drop images, drag edges and corners 
o add text boxes  

• Accepts many formats 
o jpg, tif, psd, png, gif 
o 8-bit or 16-bit; RGB or grayscale 

• Print to any print driver 
o QuadToneRIP, Epson, HP 

• Full control of ICC color management 
o Print-Tool Managed, Print Driver Managed, No Color Management 
o Rendering Intents: Perceptual, Relative, Saturation 
o Black Point Compensation 
o Epson ABW supported 
o Soft Proofing 

• Requires Mac OS X 10.9 Mavericks or newer. 
o For OS X 10.6 to 10.8 continue to use Print-Tool 1. 

  
This guide steps through the stages of using Print-Tool to create a print. Throughout this Guide 
one printer - an Epson 4800 - is used to illustrate the print setting options. Every printer has 
different settings and controls but the principle is the same for all printers. Some experimentation 
will be necessary. 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There is no substitute for experimentation. You have to try things to see how they 
work and to see if they work for you. This guide is not written as a recipe for 
perfect prints using Print-Tool. It is written to help you understand the options you 
have to gain control over the printing of your images.
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New and Changed Features in Version 2.0 

o The Page workspace is now more flexibly managed with a scrolling window, selectable rulers 
and zoomable page size. 

o One or more text boxes can now be added to the page for printing. 

o The paper selection method has been simplified. 

o Options have been added for printing digital negative backgrounds. 

o If you continue to edit an image file that has already been loaded into Print-Tool then the 
‘Reload’ button will replace the version in Print-Tool with the newly saved version. 

o Hover over (some of) the buttons or fields for Tools Tips. 
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PRINT-TOOL WORKSPACE 

The Print-Tool workspace/window has two regions, the Page and the Control Panel. It is shown 
here in the User Guide at its smallest size but it can be resized as required up to full screen. 

The Page 

The left side represents the page/
paper where image(s) will be 
displayed for printing. 

The Control Panel 

Print-Tool settings are made in the 
Control Panel. It has four areas 
referred to in this User Guide as 
Panes A, B, C and D. 
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SUGGESTED WORKFLOW 

This section outlines a workflow which will help familiarize you with the operation and capability of 
Print-Tool. It focuses on each of the Panes and the selections available. 
 
Printer and Page Setup - Pane A 

‘Printer:’ is where you select your printer 
from the drop-down. Only installed 
printers appear here. 

Select your preferred units of measure. 

Displaying rulers is optional. 

‘Page Setup: Paper and Print Settings’ 
brings up the window (right). Settings 
can be saved as the default in the 
‘Presets:’ drop-down. 

Select the ‘Paper Size:’ drop-down to 
choose your paper size. For each 
paper size there are further options 
about the print area. 

Below the chosen paper size is 
displayed its width and height 
alongside the margins of the printable 
area of the paper – as determined by 
the printer driver. The values 
displayed are not editable here, they 
arise from the ‘Paper Size:’ selection 
and define the intended extent of the printable areas. 

The bottom line of Pane A shows: 
i) The current paper magnification 
ii) Five buttons controlling the extent and visibility of the paper in the page. 

Scale to fit window / Exact paper size / 
Pixel Size: 1 pixel = 1 point / Zoom smaller / Zoom Larger. 

iii) Toggle paper orientation. 
iv) Options to show a grid on the paper.  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Placing an image or images and text onto the Page for Printing - Pane B 
 
There are two ways to place an 
image on the page to be printed. 

• Select the ‘+’button then 
navigate to the file to be 
loaded: Select File>Open 
Image. 

• Or drag the image file to the 
page from Finder. 

• If you require additional 
images on the same page click 
the ‘+’ again. If you require to 
print more than one copy of an 
image, select the image then 
the ‘Duplicate Image’ button. 
Repeat as required. 

Your selection(s) will now have appeared on the page to be printed. 

• Remove an image or text box by selecting its file name or its image and clicking the ‘-‘ button. 
• Remove all images and text boxes by clicking the button under the ‘-‘ button. 

Selecting the ‘Text’ button places a fully editable and positionable text box on the paper. The box 
initially loads in its resizable and reposition-able form (drag box / corners / edges). Clicking inside 
the box enables text entry and editing. Whilst entering text the box size automatically adjusts its 
height to accommodate more text. [Note: The automatic height adjustment does not function if 
the text box has been rotated.] The text box has blue border whilst editing. All formatting is done 
on highlighted text by selecting ‘Text’ on the Print-Tool Menu Bar where formatting options are 
selected. Text can be pasted when copied from TextEdit, Word, Pages, etc. 

Once an image has been loaded to The Page it can be edited further in your chosen editing 
software then the newly saved version of the same file can be loaded to Print-Tool by ensuring the 
image is selected in Print-Tool then hitting ‘Reload’. This replaces the initial version with the newly 
saved version. 
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Sizing and Positioning an Image or Images for Printing - Pane C 

The position and scale of the selected image 
is fully adjustable: 

• by dragging the image to the desired 
position on the paper. 

• by dragging any corner or edge to resize. 
• by editing the values in ‘Position and 

Scaling’. 
• by using the two ‘Position’ buttons to 

center the image on the paper or to move 
the image onto the paper. 

• by using the four ‘Scaling’ buttons to ‘Scale to Fit’, to ‘Actual Size’, or to ‘Zoom Smaller’ or 
‘Zoom Larger’. 

• by using either of the ‘Rotate’ buttons. 

Moving or resizing the image on the paper or changing any of the values in the ‘Position and 
Scaling’ window will automatically cause the other values to be recalculated. 

Print Color Management - Pane D 

This is where you make decisions about what 
color management policy you want to apply 
to your printed image. Taking each drop-
down or button in turn: 

a) Select your Color Management policy.  

Options are: 

• Print-Tool Managed: 
   - Print-Tool is in charge of Color Management -- The print profile below is applied. 
   - Color Management by the printer driver is turned off.  
   - Equivalent  to ‘PhotoShop Manages Color’ in PhotoShop. 

• Printer Driver Managed: 
   - Print-Tool relinquishes all Color Management functions to the OS and print driver.  
   - Color Management by the printer driver is enabled.  
   - Equivalent to ‘Printer Manages Color’ in PhotoShop. 
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• No Color Management:  
   - Print-Tool is still in charge of Color Management -- No print profile is applied. 
   - Color Management by the printer driver is turned off.  
   - Unused options are grayed out.  
   - Typically used for printing targets for creating custom ICC profiles or QTR driver curves 
   - (older versions of Photoshop used to have this option) 

b) Select the ICC profile you want to apply to the print. 

The drop-down contains the ICC Profiles available in your profiles folder. Select the one you want 
to apply. The option to select a profile is only available if you have selected ‘Print-Tool Managed’ 
above. 

c) Select your ‘Rendering Intent’ to apply to the print. 

Options are: 

• Perceptual Intent (Perceptual rendering Intent) 
• Relative Intent (Relative Colormetric Rendering Intent) 
• Relative Intent w/ BPC (Relative Colormetric Rendering Intent with Black Point Compensation) 
• Saturation Intent (Saturation Rendering Intent) 

Much has been written about the different ‘Intents’ and under what conditions they are best 
applied - all of which can easily be found on the internet. 

d) Proofing. 

Soft Proofing immediately applies the Print Color Management settings (only available in ‘Print-
Tool Managed’ - above) to the representation of the print giving an indication of the final look of 
the print. The value of this check depends on several things including whether your monitor is 
‘correctly’ profiled. This should only be treated as an indication of how the final will print will be 
rendered  

The Soft Proofing options here are: 

• No Soft Proofing (Turns Off Soft Proofing) 
• Soft Proofing (Enables Soft Proofing) 
• Proofing + Ink Black (Enables Soft Proofing and Simulate Ink Black) 

‘Ink-Black’ simulates the darkness (dMax) of the black ink. It’s effect is the same as ‘Simulate Ink 
Black’ in PhotoShop. 
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e) Epson ABW. 

Ordinarily Epson’s ABW is a not an ICC Color Managed workflow. So the standard usage is Printer 
Driver Manages color and you have the Advanced Color Settings in the Epson driver. There are 
interlocks to enforce this between Photoshop, OSX and Epson. However, Print-Tool has a special 
check box to allow usage of ICC printing profile with ABW. Check this box to allow ABW while 
using ‘Print-Tool Managed’ or ‘No Color Management’ for making profiles. 

f) Negative & Prefs. 

These are options for the printing of digital negatives. Checking ‘Negative’ turns on the 
preferences selected under ‘Prefs’ – namely black or white background and border size. There is 
also a check box to ‘Flip for Emulsion Side’. This does not flip the image on the screen in Print-Tool, 
only on the print. 

g) 8/16 bit. 

Bit control selection determines the bit depth for the color management computations. The bit 
control options are: 

Auto 8/16-bit  :  16-bit  :  8-bit 

Auto is recommended which uses 16-bit for all color management computations sent to the printer 
driver. Selecting 16-bit in the QTR drivers and Epson drivers will determine the bit depth sent to 
the print driver. 

Selecting 8-bit forces all computations to be 8-bit for time/speed reasons, 16-bit may be needed 
for drivers other than QTR or Epson to force 16-bit to driver. 

PRINTING 

Once you have selected all of your settings click the ‘Run Print…’ button. This brings up the printer 
driver for your selected printer where there are more settings to review before the print is made. 
These setting could also have been made earlier under ‘Page Setup: Paper and Print Settings …’. 
But note that under ‘Run Print …’ the options for paper size and orientation are no longer 
available. 

This works the same as if you are printing directly from any other program such as PhotoShop. 
Make your selections from the printer driver (see EXAMPLES in the next section), load your paper 
in the printer. Hit ‘Print’ to send the print instructions to the printer. 

Hitting ‘Quit’ closes Print-Tool  immediately. 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EXAMPLES 

This section shows examples of printer driver settings for a selection of different prints. The 
examples don’t cover every facet of your print drivers. Experimentation and testing will reveal 
which selections/options most suit your requirements. 

Example 1: A Color Print or a Greyscale Print (with ICC Profile)  
 

After loading the image file make your settings in the Control Panel as required.  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The ‘Layout’ drop-down in the ‘Page Setup: Paper & Print Settings…’ has 8 entries of which only 
‘Color Matching’ and ‘Print Settings’ will be discussed here. You must ensure that all 8 drop-downs 
are reviewed for your selections. 

 

Color Matching 

This image is to be printed as ‘Print-Tool 
Managed’ (set in Pane D) - meaning its ICC profile 
will be applied to the print. This results in 
‘ColorSync’ being automatically selected with no 
option to select ‘Epson Color Controls’. As no 
options are available here ‘ColorSync’ and ‘Epson 
Color Controls’ are grayed out. 
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Print Settings 

There are two windows here, ‘Basic’ and ‘Advanced Color Settings’. 

In ‘Basic’, only some of the selections are available. Choose the exact paper or one similar to what 
you have. This will also select the type of Black ink - PK (gloss) or MK (matte) in the case of Epson 
4800 UC printers. See the Epson driver documentation for additional information if needed.  

This is the equivalent to printing directly from PhotoShop where you have selected ‘PhotoShop 
Manages Colors’. 

Selections in ‘Advanced Color Settings’ are disabled. The display here shows your selected media 
type and the ICC profile the printer driver ‘thinks’ is correct. This has been overridden by your 
earlier choice of ICC profile. As this is a standard printer driver screen it cannot be amended to 
display your actual profile choice. 

 

Clicking ‘Run Print…’ brings up the Epson 4800 printer driver where you will make any final print 
settings. The printer driver window overlays the Print-Tool workspace. Make your selections from 
the printer driver, load your paper in the printer, then hit ‘Print’ to make your print. 
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Example 2: A Grayscale Print 

A grayscale image to be printed on 11x14 paper using the QuadToneRIP driver for the Epson 4800 
using Epson UltraChrome inks - QuadToneRIP printer name is Quad4800-UC. 
 

This example illustrates the use of the QuadToneRIP printer driver available from Roy Harrington 
(follow link in the footer). It is used in Print-Tool in the same way as any other printer driver. It has 
its own settings which are illustrated briefly below and are fully explained in the documentation 
accompanying QuadToneRIP. 
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Clicking ‘Run Print…’ brings up the Quad4800-UC printer 
driver where you will make your final print selections. The 
printer driver window overlays the Print-Tool workspace. 

The ‘Layout’ drop-down has 6 entries of which ‘Color 
Matching’ and ‘QuadToneRIP’ will be discussed here. You 
must ensure that all 6 drop-downs are reviewed for your 
selections. 

Color Matching 

This image is to be printed as ‘Print-Tool Managed’ (set in Pane D) - so the ‘Color Matching’ drop-
down offers no options – they are grayed out as in Example 1. 

QuadToneRIP 

The use of the extensive capabilities of QuadToneRIP is 
covered in detail in the documentation that accompanies 
it. 

Make your selections from the Quad4800-UC printer 
driver, load your paper in the printer, then hit ‘Run Print’ 
to make your print 
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Example 3: A Grayscale Patch Target for ICC Profiling 

A 21x4 step random patch target to be printed on A4 Ilford Smooth Pearl paper using the 
QuadToneRIP driver on the Epson 4800 using Epson UltraChrome inks - QuadToneRIP printer name 
is Quad4800-UC. An image such as this can be used to create grayscale or RGB ICC profiles for 
specific printer, paper and ink combinations. [Creation of profiles is not within the scope of this 
guide. It is part of QuadToneRIP available via the link in the footer]. 

 
Color Matching 

This image is to be printed as ‘No Color Management’ (set in 
Pane D). This setting is essential for the production of a patch 
file unaltered by any color management; so the ‘Color 
Matching’ drop-down options are grayed out and 
unavailable. 
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QuadToneRIP 

The use of the extensive capabilities of QuadToneRIP is 
covered in detail in the documentation that accompanies it. 
Make your selections from the Quad4800-UC printer driver, 
load your paper in the printer, then hit ‘Run Print’ to make 
your print. 

This example has a sample QuadToneRIP driver screen. It 
could equally have been for any other printer driver such as 
the Epson 4800. The ICC profile that you will create from 
measuring the printed patches is specifically for the 
combination of printer, paper, ink and settings you have 
made within the driver. If you wish to use alternative 
settings for your final print you will need to print a 21x4 
step random patch for each of the alternative settings to 
create the corresponding ICC profile. 
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Example 4: A Grayscale Patch Target printed with ABW for ICC Profiling 

This is a variation on Example 3 - a 21x4 step random patch target is to be printed on A4 Ilford 
Smooth Pearl paper using the Epson 4800 driver and Epson UltraChrome inks. This patch file is to 
be used to make an ICC profile for prints utilizing Epson’s ABW settings to ‘tone’ the final print. To 
make an ICC profile suitable for the tone settings required it is necessary to check the ‘Epson ABW 
Mode’ box (in Pane D) to enable the settings to be selected in the printer driver for printing the 
patch file. 
 

Print-Tool: Roy Harrington Page !  of !  User Guide: Steve Gledhill 16 19
www.quadtonerip.com Print-Tool 2.0 – September 2016 www.virtuallygrey.co.uk

http://www.virtuallygrey.co.uk


Color Matching 
 
This image is to be printed as ‘No Color Management’ (set in 
Pane D). This setting is essential for the production of a 
patch file unaltered by any color management. In the case of 
ABW however, there is the option to ‘tone’ the print using 
the ABW Color Controls in the driver. Selecting ‘Epson Color 
Controls’ here (under the Color Matching’ drop-down) 
enables ABW in the ‘Print Settings’ drop-down. 

Note: in this example against ‘Presets:’ the settings you 
make can be named and saved for reuse - in this case: ‘ABW - ICC - H4V4 - A4 Tray’. 

Print Settings for ABW 

Under the ‘Print Settings’ are two tabs - ‘Basic’ and 
‘Advanced Color Settings’. 

These are the normal printer driver settings for this 
printer. Under ‘Color:’ select ‘Advanced B&W Photo’ 
along with whatever other settings you require. This will 
then enable the display of the ‘Advanced Color 
Settings’ where again you select what you require. 

In this example the print is warmed slightly with 
an H=4 and V=4 setting. This example is to print a 
21x4 step random patch target to be measured to 
create an ICC profile. The profile that you will 
create from measuring the patches above is 
specifically for the combination of printer, paper, 
ink and settings you have made within the driver. 
If you wish to use alternative settings for your final 
print you will need to print a 21x4 step random 
patch for each of the alternative settings and 
produce the ICC profile to match. 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IMPORTANT 

Examples 3 & 4 are both about printing 21x4 step random patch targets with which to create 
your own ICC profiles for making monochrome prints with Print-Tool. Whatever settings you 
make in the driver (QuadtoneRIP, Epson ABW or any other) for printing the patches you 
should use the same driver settings for your final print matched with its ICC profile. Naming 
and saving settings as ‘Presets’ is recommended. 

================================================================================= 

NOTES 

The workflow above is suggested but the actual sequence in which these steps are carried out is 
not important. It is important is that you have made all the selections before hitting the final ‘Print’. 

If you have placed more than one image to print on a page then all of the selected settings will be 
applied to each and every image. 

================================================================================= 

COLOR MANAGEMENT NOTES – Roy Harrington 

Color Management is mostly thought of for printing color but the ICC standard has always 
included a grayscale format that can control the lightness/darkness tonality - essentially like a 
grayscale PhotoShop Curve.  Hardly anybody cared about this so it was not supported much.  QTR 
added some tools for creating grayscale ICCs way back.  They were a bit harder to use on 
Windows but on the Mac it all worked just like color profiles.  It all worked beautifully until CS4 - a 
long time ago.  Due to a lot of internal changes like 64-bit programs, the grayscale CM stopped 
working when printing from Photoshop to QTR driver.  I spent a lot of time with Apple and Adobe 
to have them fix this but no such luck. In fact later on they even made it hard on the color people 
by dropping No Color Management from Photoshop. So you couldn't print the color targets for 
making custom ICC profiles. All this led to me writing Print-Tool - first as a CM fix and then as a 
general easy to use layout program. 

Color Management has become increasingly difficult to understand. Conceptually its not that 
complicated but in practice its hard to know which component of the whole system is doing what, 
and how. In general there are 3 main CM players - the application (PhotoShop, Lightroom, Print-
Tool, or something else), the operating system OS X (with Colorsync as Apple's Color Management 
System) and finally the driver (for example an Epson printer driver or QTR printer driver for B&W). 
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Unfortunately they all want to get in on the act - but you need EXACTLY ONE to do the actual 
color management conversion. 

The concept is to print out a target with no color management happening, measure it and then 
create a profile. From that point on you print introducing ONLY THIS PROFILE into the print 
workflow. The important thing though is that all the settings while printing have to be IDENTICAL 
to those that were used when printing the original target. 

Problems arise if you use different print settings: 

 ◦ if you print with different applications which might do different things, 
 ◦ or if you print with a different OS something is probably different, 
 ◦ or if you have a different driver version something may have been changed. 
Not that all these things are likely to be a problem but sometimes, unpredictably, they are. 

In practice it usually depends from where the profile came. Epson profiles for Epson papers for a 
specific driver tend to work well. Downloaded profiles from someone/paper manufacturer are 
harder to know how they were made. A personal example for a custom paper showed one printer's 
profiles too light and one too dark. Profiles made with Print-Tool made both printers work 
correctly. 

It is important to always use OS X Print Presets to make sure you have consistent settings. CS6 is 
particularly tricky here because there are settings in the Preset and settings stored with the image. 
Make them all the same. Most of the settings show up on the Print Settings print dialog pane but 
the Color Matching pane can also be important. Now both Photoshop (CS6 to CC) and Print-Tool 
will disable the Color Matching pane i.e. all grayed out, when using the "Photoshop Manages 
Color" or "Print-Tool Managed" color management. 

=================================================================== 

QuadToneRIP and Print-Tool 

On Mac there are now two separate products.  The long time QTR driver runs as an ordinary print 
driver in the OS. It’s a specialized print driver for B&W output. You can print with any program you 
like - naturally PhotoShop has been the usual. In late 2012 I introduced a new program called Print-
Tool for high level image layout. Print-Tool is somewhat like the QTRgui front-end (for Windows) 
but its capabilities are a lot closer to something like Qimage.  Print-Tool and QTR are completely 
independent, so you can do PhotoShop to QTR driver, Print-Tool to QTR driver, or Print-Tool to 
Epson driver.

Print-Tool: Roy Harrington Page !  of !  User Guide: Steve Gledhill 19 19
www.quadtonerip.com Print-Tool 2.0 – September 2016 www.virtuallygrey.co.uk

http://www.virtuallygrey.co.uk

